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Commotion’s Essentials

This guide provides a profile of Commotion™’ s features and describes basic
functions such as opening clips and working with frames once they are open.
For more in-depth information please refer to the subsequent reference chapters.

Optimizing Commotion™

Turning off Background Tasks

For maximum performance and for highest speed playback of footage, it is
advisable to turn off any background tasks that may be running on your Mac.
Thisincludes File Sharing, Screen Savers, and any other control panel devices or
units that could affect the general responsiveness of your Mac.

Allocating More RAM to Commotion

Commotion’s™ ahility to play back footage at high speedsis dependent on pre-
loading clips into RAM, thus bypassing the speed barriers associated with
accessing large image files from hard disks. A 720* 486 pixel file at millions of
colors will take up about 900k per frame; with 100 megs of RAM allocated to
Commotion you will be able to load approximately 90 frames. The number of
frames that can be played by Commotion’s™ isincreased by allocating to the
application as much available RAM as possible.

Changing Application Memory Size

1. Whileinthe Finder, choose “ About This Macintosh” from under the Apple
Menu.
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2. Refer tothe Largest Unused Block value. This values shows the amount of
memory currently available. Subtract about 2MB from this value for
system use, and note the result.

3. Closewindow by clicking in the box in the left hand corner.
4. Select the Commotion™ icon but do not launch it.
5. Choose Get | nfo from the File menu (Command-1).
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6. Setthe Preferred Size option to the amount of memory you noted in Step 2.

7. Close the Commotion™ Info window.

Using RAM Efficiently within Commotion

To work more efficiently within Commotion there are several techniques which
will allow more frames to be loaded into RAM. Here are hints to increase the
number of frames that can be loaded into RAM and to increase the speed of
playback of thelive frames.

To Increase number of frames loaded

These three options are all adjustable whilein the load frames dialog box.
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Use smaller images by loading less than 100% scale.

Use alower color depth. 256 colors will permit playback at speeds four
times faster than millions of colors.

Load just a SubWindow area. (see Loading Frames)

Loading a SubWindow will allow just a certain portion of aclip to be
opened which will increase the number of frames loadable proportionately
to the size of the SubWindow.




Increasing playback speed

These tips are for increasing the speed of playback. Y ou can do them at anytime
while the clip window is open.

Select a section of the image using the Viewer Tool. The Viewer Tool
restricts the playback of the footage to the selected area. The Viewer Tool
can be used like the Marquee tool to select multiple areas of the image by
using the Shift and Command modifiers. (See Viewer Tool)

Resize the Clip window to just show the area of interest. When the window
isresized playback is limited to the visible area of the footage; while
playback is occurring, you can use the Hand Tool to move about the footage
to monitor different areas.

Video Cards/Built In Video

Playback speed greatly depends on the way your computer processes data to the
computer monitor. If you have a Macintosh 8500 or 8600 or any computer with
video input built onto the mother board, Commotion will be able to give you
real time playback of D1 resolution images. Built in video bypasses the
PCI/Nubus bus which results in very fast performance.

If your computer has a Nubus or PCI based video card, playback performance
will depend on the quality/speed of that board and its drivers. The Twin Turbo
Video Card by IX Micro (formerly IMS) will playback aD1 rez image at greater
than 30fps. It isimportant to make sure you have the latest drivers for the Twin
Turbo Card—you can download the drivers from their World Wide Web site at
www.ixmicro.com. Other PCI and Nubus videoboards will yield varying
results.

If you have more than one monitor connected to your system, make sure to test
playback performance out on both monitors to establish which videocard is
providing the higher performance.



Quick Start - Animation

Making a Clip and Animate a Crawling Snake

To illustrate how to start a Commotion™ clip on ablank canvas, it is helpful to
walk through an example. This section will walk you through the first steps of
creating a clip and a simple animation.

1. Select New fromthe File menu. Thefollowing dialog box will appear:
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2. Typeinthesize of imagedesiredin x and y pixels. For the example enter
320 for the x value and 240 for the y value.

3. From the pop-up menu select color depth. Leave the color depth at millions
of colorsfor this exercise.

Choosing a lower color depth will allow more framesto be
loaded into RAM. Painting can only be done at millions of
colors and 256 colors/grays.

4. Typein the number of frames you would like allocated in RAM. Additional
frames can be added to the clip later. For this demonstration leave the
number at the default value of 10. (After al, more than 10 frames of a
crawling snake gets old.)

5. A blank window will appear. Y ou may begin painting on the frame.

6. Select asmall brush with soft edges from the brush palette. If itisfolded
up, click on the triangle in the left hand corner to expand the menu.

7. Click on one of the default colors of your choice from the color swatches
palette.

8. Starting on frame 1 paint a small line on the canvas.



9.

10.

11.

12.

To advance to the next frame click on the single frame button on the Player
window. You can aso usethe right and left arrow keys to toggle through
the frames.

Click on the onion skinning icon at the bottom of the clip window to
turn the onion skin on. Thiswill show you atranslucent image of the first
frame you painted, thus aiding in a more fluid animation.

|' . a— % T Y
\
B e L |
Tl g Pb T ST — T TRr—
|
L& , |

Repeat step 8 for each of the following frames, making sure to draw the line
around the canvasto make it look asif it were a snake crawling around.
When you reach the end of the ten frames you can either tap the space bar to
play/stop the clip back or hit play on the player palette. If you have the
onion skinning feature on, it will play with it on too. To see what the clip
actually looks like, click on the onion skinning icon to turn off the feature.



Painting Functions

Commotion™ gives you not only the ability to paint over time but as soon as
you paint a stroke you can play it back at real time speeds. This eliminates the
need to render the clip or export your work to another program.

Select the type of painting tool desired from the tool palette by either
clicking on it or using the keyboard shortcut.

Select the brush from the brush palette or create your own brush. (See
Creating a Brush.)

Choose the foreground color by clicking on the color in the color
palette or by using the color picker. (See Picking a Color) You are
now ready to paint.

To make animation easier turn on the onion skinning feature.

Working with Brushes

Commotion offers avariety of sizes and hardness of brushes. It ispossibleto
choose one of the default brushes by clicking on it or create your own brush.

Creating a Brush

When creating a brush there are two options available. Y ou can size the brush
on the fly or set brush options using the brush options palette.
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1Please Note: In this version of Commotion™ the creating a brush on the
fly feature only works of you have selected one of the default brushes and
1then create your own. It will not work if the brush options have been
‘adjusted manually in the brushes palette.

To interactively create a brush while you are painting:

1. Hold downthecommand andoption keys.

2. Click-drag the mouse to create a custom size brush.

3. To create round brush hold down the shift key, thiswill lock the aspect
ratio.



4. To adjust the softness (feathering) of the brush edges, hold down the
control key and drag inward. When you are done release the mouse button.

To set brush options manually

1. Under the Brush Controls palette double click on the name of the option to
bring a dialog box and manually type in the numeric value.

2. You may also click on each of the five brush characteristics and slide the
values |eft or right to adjust the options.
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Size - Controls the diameter of the brush.

Feather - Controls the softness of the edges of the brush.

Spacing - Controls the distance between the brush marksin a stroke.
Angle - Specifiesthe angle of an elliptical brush against the “canvas’.
This creates a chiseled stroke similar to afountain pen.

Round - Specifies the roundness of abrush. 100% isacircular brush
while avalue of 0% would be aflat or linear brush.

Saving a Brush

1. If you have created a brush you would like to save, hold down the shift key
to access the paintbucket.

2. Click onthe open area at the bottom of the brushes palette or on top of
another brush to load the brush.

Deleting a Brush

1. Hold down the command key to access to scissors.
2. Click onthe brush in the brushes palette you wish to delete.



Picking a Color

Commotion™ has an entire palette of default colorsto paint with, however if
you should find that you need a custom color there are several options:

Select one of the default colors from the color palette

Mix acustom color using the scratch palette

Double- click on any of the colorsin the color palette or on the
foreground/background color to access the standard Macintosh color picker.
Use the eyedropper to sample a color from an image.

Hold down the option key to quick cut to the eyedropper and click on a color
to select it.

Saving and Deleting a Color

1
2.

3.

To save acolor hit the shift key to access the paint bucket icon.

Go to the empty bottom area of the color palette and click the mouse. You
may also replace default colors this way.

Hitting command will give you the scissors - click on a color in the palette
if you want to delete it.

Onion Skinning

When painting arange of framesit is often useful to be able to see the frame
preceding and/or following the one you are currently working on.

There are two ways to activate onion skinning:

Select Onion Skinning from the Edit Menu
or

Click on the Onion Skinning icon located at the bottom of the
clip window.

Y ou can set the opacity of the onion skinning as well as other options under the
Prefer ences command located in the File menu.




Quick Start - Opening a File

When opening afilein Commotion™ there are three options to fit various
formats. For opening aclip in the form of asingle file with asingle file name
use the following instructions.

If you would like to open aclip comprised of sequentially numbered PICTS,
while in the open dialog box, click on the PICT you would like to be the first
frame in the clip; Commotion™ will scan the rest of the files and open them
together asasingleclip.

For opening a clip made up of various frames with unnumbered titles, choose
the open random command from the Fil e menu. The standard open dialog
box will appear, click on thetitle of the frames you would like to appear in the
order you would like them to appear in your clip. When you are done, hit
cancel.

1. Select Open from the File menu.

2. Select animagefile (PICT or Quick Time). After you click OK,
Commotion™ will scan the folder to establish the total frame range and size
of thefile you are loading.

i fji ] *By default Commotion™ will attempt to
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When selected the preview button will show the first frame being
requested

Thefirst frame if the clip has been entered into the in box as well asthe
number of framesin the clip and the total number of loadable frames.

3. If the number of frames requested doesn’t exceed the number of frames
loadable hit OK. If not, change the out value to fewer number of frames.



Y ou can aso change which of the frames you load by diding the Live
Frames bar around. The bar can aso be expanded and made smaller by click-
dragging on the ends of it.

4. Theclip window now appears on the screen. These frames are ready to be
painted or manipulated.

Options for loading frames
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Color Depth isadjusted from this menu.

o Note: Painting framesis limited to
18 Debery Millions and 256 grays/colors. The other
.’3.‘:2:' e modes are for optimizing speed of playback.

The Crop Window command will activate the SubWindow mode so
that you can work on only a section of the clip.(See Subwindows)

T The SubWindow mode will access the
— SubWindow dialog box. See Subwindows
for more information.

The Scal e command will scale the entire clip and the window.

Seale: [“3p0] -’elf'_ A clipisscaled at adifferent resolution
1% than the original. Y ou would not want to
iy paint at aresolution different than the

255 | source clip unless you want to change the

resolution of the entire clip.




Skip/Duplicate- thiswill allow you to either skip or duplicate
framesin the increment indicated.

~#a: | Skip- this command will skip framesin
""" |the numerical increment entered.
Duplicate- thiswill duplicate frames. A
15 frame clip can be made into a 30 frame
clip by entering 2 as the value.

Subwindows

Subwindows is a special feature that allows you to open just a subsection of a
clip, manipulate it, and then save it back into its original location in the file.
By only loading the area of aclip that you need to work on, you can greatly
increase the number of frames that will fit into RAM.

For example, if you were touching up an areain a Hi-Resolution

film plate (1800*900) pixels, but only needed to work on a 300* 300 area
rectangular section of the frame, you could load 18 times more framesinto RAM
by using a SubWindow.

You can load a section of a file and have it become a new
clip by selecting Save As from the File menu.

1. Select SubWindow and click OK. The following dialog box will appear:

Position - the X,Y position in pixels of the top-left of the
SubWindow (which will be the 0,0 coordinate of the clip once loaded).
Size - the X,Y Dimensions of the Subwindow that you have selected.
Load Full Size - when this option is checked, the Subwindow will
be displayed inside of afull size window with arepresentative frame.
Thisis handy to keep aframe of reference of where the Subwindow fits

-
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into thefile. Thefull size frameisonly for reference—you will not be
able to paint/affect the area outside of the Subwindow.

Save / Load - these buttons will save a crop window setting so that
you can load the same crop area for ancther file.

Use the handle in the corner of the outlined box to resize theimage. To
move the subwindow around, click-drag the mouse. After clicking OK, the
valuesfor size, position and number of frames loadable are updated in the
load frames dial og box.

Please Note: when you’ve loaded a SubWindow, certain
operations become limited. For example, you would not want
to add or delete frames from a clip when working with a
Subwindow, as that would affect the timing of the frames
when they were saved back into their original files.




Saving

Commotion™ supports PICT and QuickTime formats.

To save a clip:
Select Save from the File menu.

The standard Macintosh dialog box will appear with afew specia options for
Commotion™.,

Subarea - This option is only available when the clip you are saving
was loaded as a subclip from afile. Thisoption will be on by default,
which will save the element back into its original section of thefile. If
turned off, the clip will be saved as a new file and will subsequently
cease to be a Subwindow clip.

Save Alpha - When checked, Commotion will attempt to embed the
8-hit alpha channel into the file format you are saving. If you choose a
file format that does not support embedded alphas, the alphawill not be
saved.

Save QT Layers- If you are saving as a QuickTime Movie this
option allows you to save the QuickTime Layers.

e R B A Save File As pop-up menu also appearsin the

AN e

i Save di_al ogue l_Jox, alowing you to select a format
! Bk T b for savi ng thefile.

FIL%




The Player Palette

The Player palette allows you to move through the frames in the loaded clip.

Y ou can move to the beginning or end of the clip currently loaded into RAM,
play the clip in the normal or reverse direction, or advance asingle framein
either direction by pressing the icon buttons in the palette. The a new range of
frames can also be loaded into RAM, and the Virtual Frames and Ganging
function can be toggled on or off. The frame rate of playback can also be set
using a pop-up menu.

Goto Beginning/End
The left-pointing icon moves the display to the first frame in the currently-loaded clip.

E The right-pointing icon moves to the last frame in the currently-loaded clip.

Play/Reverse

m Playback speed will be reduced

Thisicon playsthe clip in reverse. greatly if there are palettes or

m other windows on top of the clip
Thisicon plays the clip forward. window.

Single Frame Advance
E This arrow will advance the clip one frame backwards

This arrow will advance the clip one frame forward.
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Press the square icon to stop playback.

Rock n” Roll

4

By clicking on thisicon the live frames will play to the end and then play in reverse.



Clicking om these arrows

Live Frame Range . | 1 D ag | will move the live frame
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Changing the Range of Live frames

To changetherange of Live Frames, dragthe liveframes bar either right or
left. The start and end frame numbers will change while the number of framesin
RAM remains constant.

The In/Out Frame Range

Thein/out frame range is the range of frames on which afilter, calculation or
effect will be applied to.

In/Out & Live Frames L ock Together

E By pushing the lock button the in/out range will be set to match the
current LIVE FRAMES range.

Frame Rate Pop-up

This pop-up menu allows you to select the target frame rate (in frames per
second) for playback. The speed that Commotion will play back your clipis
influenced by the limitations of various computersi.e. video card, VRAM, etc.
The pop-up menu has the options Max, 30, 24, and Var.

M ax playsthe clip at the maximum rate possible for the size of the canvas,
the configuration of your system, and any limiting factors such as
calculations or windows covering the clip window.

“30" playstheclip at 30 fps, the standard US video rate.

“24" playstheclip at 24 fps, the standard film frame rate.



Var brings up adialogue box requesting a keyboard input for the playback
speed; Commotion™ will play back the clip at the speed entered or the
closest rate possible.

Auto Spooler

The Auto Spool Button will turn on and off the loading of Virtual

Frames.

- If the button is off the range of frames loaded into RAM will remain
constant and loop through only the frames that are in RAM.
If the button is on when you reach the last frame loaded into RAM, the first
frame loaded is cached to a scratch disk and the next framein theclip isthen
loaded into RAM. The number of framesin RAM remains constant but
with the Auto Spooler on, Commotion™ will continue to add the next
frame in the clip into the live frames while caching out the last frame in the
range to the scratch disk. This does not occur during playback, only when
advancing the framesone at atime.



The Tool Palette

The Tools Palette controls Commotion’s™ functions for
painting and making selections. Y ou can click on any of the
tools to make them active or you can use the keyboard
shortcut. In addition to the paint tools that appear in virtualy
all painting programs — such as paintbrush, airbrush, and
marquee — Commotion™ has tools specially designed for
painting and editing over time. Most of the tools also have a
set of options for customizing your painting; these options
appear at the top of the Options palette.

The Rectangular Marquee Tool is used to make rectangular selections.
ThelLasso Tool is used for drawing free-hand selections.

@ The View Window Tool alows you to draw a subwindow in a clip and to playback just what
isinside the window. If you have a selection made the selection will remain.

]
_# | ThePen Tool isused to draw path shapes and rotosplines. double clicking on the pen tool
will bring up the rotospline window..

|£| The Magic Wand selects all neighboring pixels within a preselected color range.
TheMove Tool alowsyouto move a selection within the active clip.

The Paintbucket will fill an area of similarly colored pixels with another color.

The Eyedropper Tool is used for sampling colors.

The Airbrush adds paint with pressure, simulating painting with an airbrush.
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The Paintbrush paints brush strokes.



TheLineTool isused to draw straight, solid lines.

The Gradient Tool is used to create a variation of color across a selection.

&

The Eraser isused to erase areas of a drawing.

The Pencil tool draws hard edged strokes.

The Clone Brush copies pixels from one area of an image to another.

The Super Clone Brush will copy pixels from one frame to another or across clips.

The Wire Removal Tool removes wire or wire-like artifacts by seaming or cloning pixels.

IE' TheBlur Tool softens (or blurs) hard lines or edges.



Wire Removal and Clone Brush Tools

Two of Commotion’s™ unique paint tools are the wire removal tool and the
clone brush toals, shortening the steps between a good start and the finished
image.

Clone Brush Tools

A very useful ability for touching-up photorealistic images is the capacity to
clone pixels from one area to another. Thisway subtle variations of color can
be maintained. Cloning isalso important if you are using footage at allow color
depth that has been dithered; simply painting onto a dithered image is very
difficult if the imagesis meant to look at all realistic.

Commotion™ has two clone brushes which paint by copying pixels from a
source to atarget. Thefirst islike those common in static image editors, and
the second is designed to take advantage of the multi-frame and multi-file
capabilities of Commotion™. Both allow the moving picture artist to paint
out unwanted items such as boom microphones or to remove dirt or blemishes
from a shot, resulting in unlimited creative possibilities.

The Clone Brush Tool:
Use thistool if there is aflaw you wish to remove in an area with little detail.

1 Select the clone brush tool from the floating tool palette.

2. Choose areference point- thisis the area around which pixels are copied.
As you begin painting somewhere else in the frame the pixels are copied
from the reference point to the new point.

The Super Clone Brush Tool:

Thisisthetool to use if you want to clone from another frame or even another
file. The Super Clone Brush window gives you four settings for clone source.
F1 through F4 in the function keys will toggle between the four sources.



EY
1 Select the Super Clone Brush Tool from the floating tool palette
menu. Double click to bring up the Clone Brush Window.
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2. Thetitles of al open clipswill appear in the pop-up menu. Y ou can assign
up to four separate clips or the same source four times as clone sources.
The paint bucket will appear next to the active source for the cloning.

3. Set Relative and Absolute values as necessary. Relative would be a positive
or negative number relative to the number of the frame you are cloning to.
Absolute is the exact frame number you wish to use as a clone source.

4. If you need the clone source to be offset from the image being cloned to,
adjust the x,y offset values.

5. Click-drag around the area you wish to replace.

Hitting the shift key will show you a transparent image of the clone source.
Holding down the shift key while click-dragging will allow you to offset the
X,y positioning of the clone source.

Painting while holding down the command key will allow you to paint
from undo.

Wire Removal Tool

Thewire removal tool is designed for the express purpose of removing wires or
scratches on the film. By blending or cloning the pixels on either side of the
artifact you are removing, Commotion™ leaves a seamless image with no hint
of artifacting.

To use the Wire Removal Tool:

N d

1 Select the Wire Removal Tool from the floating tool palette.

2. Click drag on awire or any wire-like artifact. Commotion™ will do the
rest.




Rotosplines

Rotosplines are Commotion’s™ paths for specifying shapes for mattes. A
rotospline - or just aspline - is a series of points connected either by straight
lines or by bezier curves. Mattes that are defined by a distinct path, like those
made from splines, are a common means of extracting foregrounds and
backgrounds of special effect shots. Hereis an overview of the splinetoolsin
Commotion.™

Creating a Selection/Path

1 EI Select the pen tool from the tool palette menu.
2. Click the mouse to establish straight line points or drag-click to set points
with curved segments.
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By selecting the pen tool in the tool box you now have accessto the
other roto tools.

k To make a point on the path active select it with the direct-
selection tool.

M~

Y ou can change the points of the curve from straight connecting
lines to bezier curves by clicking on them with the convert point tool.

&

{E' Points can be subtracted by using the pen tool with the minus
sign in the corner.

Keyframes are automatically added each time you modify the shape.
You can select all of the points by hitting Command-A on the keyboard
or by drawing a box around all of the points with the mouse.

Y ou can add points using the pen tool with the plus sign.




Scaling a Selection/Path

1.

i

Select the Scale Path tool from the Rotospline pal ette.

2. Click the vanishing point you would like the path to scale towards.
3. You can now drag-click the mouse around the first point selected to scale the

path.

the aspect ratio.

Holding down the Shift key while scaling the spline will lock

Rotation of a Selection/Path

1.

O

Select the Rotate Path tool from the Rotospline palette.

2. Click on the point around which you would like to rotate the spline.
3. You can now drag-click the mouse around the first point selected to rotate

the selection.

Fill, Feather, Saving, Loading and Creating Splines

ﬂ m IEI . Either the inside or the outside of each spline

shape isfilled with either white or black; you specify the side and the
color of thefill for each spline by clicking on the fill quality icon.

SRR M Commotion will feather the matte created from your
splines either to the inside, outside, or both sides of your spline, which
you specify by clicking on the feather icon. You can set the feather
radius in the small number box next to the feather icon.
You can save or load either single or multiple splines by selecting the
desired function from the rotospline pop-up menu on the rotospline

al ette.

D @ Y ou can add or delete a spline by clicking on the respective
icons when the desired spline is active in the spline palette.




Preview, Curve, Render

[Preview:l |: Curve :I [Eender:l

Preview - generates a preview of the apha channel according to the
present splines and their configurations. The preview appears either as
agrayscale matte in a new window, as atransucent colored overlay on
your original, or as a matte applied to your clip..

Curve will bring up the Path Curve Editor, which allows you to
change the interpolation between path keyframes.

Render creates a composition of the present splines and their
configurations and places this composition in the apha channel for the
selected clip or in either a new (open) clip or aclip saved to disk. The
new alphais calculated over thein/out frame range.



